
CODE Introduction  

                     

 

 
Lab Instructions 

 CODE Designer 



CODE Introduction  

 



I N T R O D U C T I O N  T O  C O D E / 4 0 0  

  © Copyright Partner400, 2003.                                                                                 Unit 4 - The CODE Designer - Page 1 of 17 

THE CODE DESIGNER 
Using an editor to create and maintain DDS source for your display and printer files can be a 
frustrating and difficult task.  What would be great is a graphical design tool that let’s you design 
your screens and reports visually and then generate the DDS source for you.  Well that’s exactly 
what CODE Designer does for you. 
 
The CODE Designer interface was designed to help the novice DDS programmer create screens, 
reports and databases quickly and easily without worrying about the details of the DDS 
language. At the same time it allows the expert DDS programmer get access to all the features 
and power of the language.  We’ll now step through each part of the interface and update some 
DDS as well. 
 
Before we begin the CODE designer, we need to understand the concept of a group.  A group is 
simply a collection of one or more DDS records that make up a single screen or report.  It is the 
set of records that is written by the application to the display or printer device at one time.  
Grouping records together allows you to work on one record while still seeing the related records 
in the background.  The Workbook has a Design page tab for each group defined for quick 
access to each group of records.  We will see this design page later. 
 

Starting the CODE Designer 
 
You can jump straight to this section without completing the CODE Editor section but you must 
have established a connection with the host as discussed in the  Connecting to OS/400 in Unit 2. 
 
Let’s launch the Designer and load a display file. 
 
� From the Start - Programs - IBM WebSphere Studio - Development Studio for iSeries - 

CODE menu, select CODE Designer.  The Designer appears with no DDS loaded. 

� From the File menu, select Open...  The Open dialog appears. 

� Click the + beside <OS400> to show the library list. 

� Click the + beside CODELABxx to show the library. 

� Click on the source physical file QDDSSRC to show its contents on the right. 

Unit 4
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� Click on MSTDSP DSPF and then click on the OK push button.  The source is loaded into 
the Designer. 

� You may see a Group Properties window appear when the member is loaded into the 
Designer. This means that no Designer groups have been defined for this member yet.  If you 
see the Group Properties window, create a group using the instructions that follow in the next 
2 paragraphs.  Otherwise, click on the MAIN_MENU group tab on the design screen and 
proceed to the next bullet.   

We will create a group with one record format in it called MAIN_MENU.  Change the group 
name by typing over the SCREEN1 name given originally to name it MAIN_MENU. 

   
Next, select (highlight) the SELECT record format from the “Available” list and Press the 
>> button to put that record into the “Selected” list for the group.  You have just created the 
MAIN_MENU group and you should now see the screen format appearing in the main 
section on the top right of the Designer screen.  Note that a tab associated with your 
MAIN_MENU group was also created.  Close the Group Properties Window. 
 

� Next we will take a look at some of the things we can do in the Design Page.  Select (by 
clicking on it) the static text in the heading line “Maintenance Selection”.  Note that the DDS 
line of code for this text appears in the bottom right window and the text field is highlighted 
with a box.   Also notice that you can see many of the attributes of this static text field in the 
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top portion of the Design Page.  For example, you can see its length (21) and its color 
(green).  Click on the Pulldown arrow to the right of the green color indicator.  Select a 
different color for this static text field and see what happens. 

� Double click on your selected static text field to open its Properties Notebook.  Note the 
current values for Row and Column positioning.  Leaving the Properties Notebook open, 
drag the static text field with your mouse to a position approximately 1 line below and 8 or 
10 spaces to the right of where it was originally.  Note the Row and Column values change 
when you release the mouse, dropping the field in a new position.  As you will see the DDS 
in the bottom right panel has also changed.  Explore the contents of some of the other pages 
of the Properties Notebook, and the close it. 

�  We probably would prefer to have our text field centered again.  Right click on the selected 
field and select Align and Center Horizontally from the pop up menu.  That was a little 
easier than SDA wasn’t it! 

� Now select one of the 3 single character input capable fields (a B appears in the field to 
indicate both input and output just as it does in SDA).  Notice that the name of the field 
appears in a box above the Design Window (near the middle).  Select a different input 
capable field and observe that the field name changes.  Note also that the appropriate DDS 
line of code always appears in the bottom pane. 

� You can change the length of a field in many different ways. You can use the up/down 
arrows on the length box at the top of the design window (to the right of the field name).  Try 
it and see what happens.   

� You can also change the length by grabbing the edge of the selection box and dragging to 
make the box bigger (wait until your cursor becomes a 2-headed arrow before dragging).  
Before leaving this field, set its length back to 1.   

� We will now add a new static text field to the record format.  Find a nice empty spot on the 
Design Screen – perhaps between the entry fields and the message field (named EMESS) 
near the bottom of the screen.  Simply type in whatever text you want to place in the field – 
do make sure though that you have at least 3 or 4 separate words in the text.  Do not worry if 
you make some a typing mistake – you can backspace to correct them without interfering 
with the other fields on the screen!  Try doing that with SDA and see what a mess you 
make!! 

� Using your mouse, select the text you just entered.  Notice that, unlike SDA, CODE designer 
created a single text field from all the words you keyed together! Pick up your new field and 
move it to any empty spot on the screen by dragging.  Note that you can easily place it 
between other lines or fields, such as just below the heading lines.  As you can see, it’s quite 
easy to edit existing display screens using CODE designer and the Design Window.   

� Remember that you MUST have the record format in a Designer Group before you can work 
with it in the Design Window.  To get some extra practice in doing that, let’s now create a 
second group for another record format using the steps below. 
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� Select the MAIN_MENU group form the list in the far left side pane of the Designer page.  
Right click on MAIN_MENU and select Insert Group… from the pop-up menu. A Group 
properties notebook appears and a blank Design page for the group SCREEN1 will also 
appear. 

� On the Group properties notebook, click on the record EMPSEL in the Available list box 
and click on the  button.  For simplicity this is the only record we will add for now.  The 
Design page will have been updated to show us what the record EMPSEL looks like. 

� Name the group by over typing SCREEN1 with EMPL_SELCT.  The resulting dialog 
should look like the image below.  

 

� Close the Group properties notebook by clicking on the X in the top right corner 
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The DDS Tree 
 
� Let’s concentrate now on the left side pane of our CODE screen. What you are looking at is 

basically a “Windows Explorer”-like view of the DDS.  The 
DDS Tree view on the left-hand side of the Designer displays 
the DDS source in its file, record, field, and keyword hierarchy.  
It is a familiar and intuitive way to see the overall structure of 
the DDS source and to navigate through it quickly.  Don’t 
worry if you’re not a DDS expert, we’ll explain everything you 
need to know. 

   
� Click on the + beside the folder 

<OS400>CODELABxx/QDDSSRC(MSTDSP). 

� Click on the + beside the folder File Keywords. 

� Click on the + beside the record SELECT. 

� Click on the + beside the folder Record Keywords. 

� Click on the + beside the field EMESS. 

� The DDS Tree is now showing you a nice summary of the file-
level keywords and of the record SELECT.  

Notice that the Design Groups (MAIN_MENU and 
EMPL_SELCT) appear at the end of the DDS records. 

 

The Details Page 
 
In the upper right-hand side of the Designer is the Workbook with several different tabbed pages.  
The top page (far left tab) is called Details and it is the other half of the “Windows Explorer”-
like interface.  It lists the contents of the currently selected item in the DDS Tree.   
 
� Click on the Details tab. 

� In the bottom right-hand side of the Designer is the Utility Notebook.  The Selected DDS 
page in the notebook shows the actual DDS source for the currently selected item. 
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� In the DDS Tree click on the record SELECT.  The Details page lists all the fields in the 
record SELECT and summarizes some of their properties.  The Selected DDS page shows 
the DDS for the SELECT record. 

 

� In the DDS Tree click on Record keywords immediately below SELECT.  The Details 
page shows the current record-level keywords.  The Selected DDS page still shows the DDS 
for the SELECT record. 

� In the DDS Tree click on the field EMESS.  The Details page shows its field-level 
keywords.  The Selected DDS page now shows the DDS for the EMESS field. 
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Creating New Screens 
 
You may have noticed when running the application earlier that that application requires that you 
know the employee number ahead of time, instead of being able to browse what is in the 
database.  What we really need is to add a subfile lookup capability.   Normally the DDS for 
these is not easy to code.  So much so in fact that most programmers simply clone another 
subfile, with the result that they rarely use all of the options available to them.  Subfiles are much 
easier to code with CODE Designer.  Let’s try one. 
 
� Before we create a new screen, we must first create another new group.  You know how to 

do this (since you just did it in the previous steps.)  Referring back to the earlier pages if 
necessary, create a new group.  This time, however, do NOT select a record format from the 
Available list box.  We will create a new record format for this group.  Simply Name the 
Group SUBFILE and then close the Group Properties dialog. Note that the design page has a 
gray background whereas the groups we worked with before had a black background.  That’s 
because this group does not yet have a record format. 

� You can create things on the design page by selecting the appropriate tool from the palette on 
the left-hand side and then click on the design page where you want it to be created.  Right 
now, most things are disabled in the palette because there is no record in which to create 
fields.  The only two tools available are Create standard record and Create subfile record.  If 
you leave the mouse over a button for a second or two, flyover help will appear describing 
the indicated button.   

�    Click on the Create subfile record button and then click in the dark 
gray area.  A subfile and a subfile control record pair will be created for you. The one you are 
seeing now is the subfile record. To see evidence of the subfile control record, use the drop 
down arrow to the right of the record format name (it’s probably RECORD1).  Before 
proceeding to the next step, make sure you are back to having the subfile record format (not 
the subfile control record) in the design page.    

� Now click on the Create named field button  and then click in the design area 
somewhere on row 8.  Six fields appear in a vertical column.  This is because the subfile you 
created, defaulted to a SFLPAGE (visible list size) of six. 

� Click on the top field and hold the mouse down and move it to row 8, column 
5.  Note the current row and column appear just above the field as you move it. 

� Move the mouse over to the right edge of the field.  It should turn into a 
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double-headed arrow as shown here. Hold down the mouse and move it to the 
left.  The size of the field will be reduced.  The current size will appear just above the field.  
When the size is 3, let go of the mouse.  Very nice!  

� The toolbar at the top of the design page is a very convenient place to monitor and 
manipulate the currently selected field.  Rename the record from RECORD1 to 
EMPLSTSFL and the field from FIELD1 to OPCODE by simply over typing the text in 
the combo box.   

� Change the color of the field by clicking on the  button and selecting pink 
(pink?!).   Then change the usage of the field to input only by clicking on the  button.  

� Position the cursor at row 8, column 9.  Note that you can use the rulers on the top and side 
of the design screen to find the right spot.  You can use the cursor keys or the mouse to move 
the cursor. 

� If you are creating a long field with an exact length, the SDA syntax can be easier.   Type: 
+O(30).  Then select the +O(30) field by clicking on it with your mouse.  You should see a 
box around the field.  Notice from Selected DDS page that you have created a text constant 
containing ‘+O(30)’.  Not to worry – it won’t stay that way for long. 

� Hit the Convert string to field   button on the toolbar (this is supposed to look like a 
spool of thread in case you were wondering). Alternatively, you can press F11 to convert the 
string into a character output field of length 30. 

� Rename the new field to ENAME by overtyping in the toolbar.  We are going to use this 
field to show the name of the employee. 

� Position the cursor to 8, 41. Now we will add a field for the employee’s salary.  

� It would be nice if we could just tell the Designer what we wanted the number to look like 
and then have Designer generate all the cryptic EDTCDEs to make it happen wouldn’t it?  
Type $666,666.66 and then hit the back arrow to highlight the field. 

� We are going to use F11 this time to convert this field into an output numeric field with 
comma delimiters, two decimal positions, a currency symbol and no sign.  Press F11 and 
look at the Selected DDS page to see what was generated for you.  Isn’t that easier than 
remembering all those edit codes? 
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� Rename the field to SALARY and change its color to yellow, using the toolbar. 

� Our subfile seems a little scrunched to the left.  It would be nice to space it out evenly.  To do 

this simply select any one of the fields and hit  on the far right side of the 
toolbar.  Notice that the other buttons in the vicinity perform other typical alignment tasks 
(left, right, center and top). 

� Just below the palette there are three spin buttons.  The top one, Subfile size, specifies the 
total number of entries in the list that will be filled in by the application.  The second one, 
Subfile page size, is how many entries appear on the screen.  Set the Subfile size  to 300 (by 
over typing) and the Subfile page size to 9.  Notice that the design page is updated 
accordingly. 

 

Switching between Multiple Records 
� Now let’s fix up the Subfile control record.  The group we created contains 2 records.  Verify 

this by dropping down the record combo box in the toolbar.  

� Change the current record by selecting RECORD1CTL from the combo box or by hitting 

the  or simply by pressing Alt+End.  The fields in the subfile still appear so that column 
heading can be lined up, but they appear at half-intensity so that they can be distinguished 
from the fields of the current record.  We think you’ll agree that this ability to switch editing 
from one record to another is a lot simpler than the SDA approach! 

� Rename the record to EMPLSTCTL by overtyping the name in the toolbar area. 

 

Copy and Paste 
 

Let’s provide a ‘position to’ entry in the subfile control header.   

� Position the cursor at 4,9 and type:  Position to: 

� Next we need an employee name field.  We could create a named field with the right 
characteristics as we did in the subfile, or we could create a source reference using the  
button in the palette.  Alternatively we could reference the original database field using one 
of the  buttons.  But there is an even simpler way.  We can use copy and paste!   

� In the DDS Tree expand the EMPMNT record by clicking on the + beside the record name. 
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� Click on the ENAME field and press Ctrl+C.  (The right mouse pop-up menu or the Edit 
pulldown would also give us the Copy menu item.) 

� Position the cursor to 4, 23 and press Ctrl+V to paste the field into the new layout.  Can’t get 
much simpler than that! 

� Rename the field to POS_TO. 

Working with Indicators 
 
� Let’s add some error handling for the ‘position to employee name’ field.  If the employee 

name is not found in the database, the program will turn on indicator 60.  The screen should 
turn the field red, reverse image and position the cursor to it.  Now wouldn’t it be nice if we 
could work something higher level and easier to remember than some arbitrary number from 
1 to 99. 

� Click on the  button on the design page toolbar (or press F7). The Named indicator sets 
dialog appears. 

� In the Settings name field, type: Not Found for the name and press the Create button. 

� Click on the checkbox next to 60 and press OK.  The ‘Not found’ indicator set is now in 
effect.  The design area will be shown as if indicator 60 is on and all other indicators are off.  
The design page toolbar shows the name of the current indicator set in use in the combo box 
on the bottom left.  The Designer will remember this indicator set for us so that we can re-use 
it at any time.  We think that you will agree that this is a much easier way of applying 
indicators for test purposes than that used by SDA where you have to key the indicators over 
and over and …… 
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� Now select the POS_TO field.  

� On the toolbar, select the color red and the 
display attributes reverse image and position 
cursor.  The set of toolbar buttons representing the current display attributes is found just 
below the color button).  These buttons are toggles that are on (pushed) or off.   

� Examine the DDS generated in the Selected DDS page. 

� Notice that all the new keywords were created with a conditioning indicator of 60 applied.  
The DSPATR(PR) keyword was copied in when we pasted the field originally and so is not 
conditioned. 

� Now let’s try it out!  From the Named indicator sets combo box, select All indicators are 
off.   As you can see this stuff really works! 

� From the Named indicator sets combo box, select your own set Not found.  The field appears 
red and reverse imaged (or whatever other combination you selected). 
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The Properties Notebook 
 

Second to the direct manipulation and the toolbar on the Design page, the easiest and quickest 
ways of getting access to the properties of a field, record, or entire file is a Properties notebook.   
 
There are a number of ways in which you can get to a Properties notebook.  
 
� From the Selected menu pull-down select 

Properties.  Notice that F4 is identified as 
the keyboard shortcut (F4 = Prompt – 
makes sense in a way).   

� Now click on another field.  Notice that the 
properties dialog changes to reflect the new 
field.  This is useful when you need to 
change the properties on a number of 
fields.    

� Close the properties notebook by closing it 
(clicking on the ‘X’ in the upper right of the dialog window).  

� Another method of displaying the properties notebook is to double-click on anything in the 
DDS Tree, the Details Page, or the Design Page.  Try those options now to see how it works. 

� In the DDS Tree, click on the record SELECT and press F4 to see the Record properties.   
Notice how, as you select different items, the Properties notebook will continuously update 
itself to show you the properties of the current selection. 

� Now click on the *DATE field in the SELECT record.  (You may have to move the 
properties notebook out of the way.) This field has a different set of pages describing its 
properties. 

� Let’s say we want to change the year from 2 to 4 digits.  Click on the Length of year 
checkbox. 

� Select the 4 digits option from the combo box.  Notice how the sample is updated on the 
properties notebook. 

� To test the Design page, click on the MAIN_MENU tab in the workbook and look at the 
upper right corner of the screen.  The date should now have 4 digits. 
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� Next click on the EMPAPL field in the SELECT record.  On the Field Properties notebook 
click on the Basics tab.  On this page, you can change the field’s name, usage, length, type, 

and screen position.  The other pages give you quick access to other properties for this field. 

Adding New Keywords 
 

Hopefully by now you can see where CODE Designer helps you to manage the visual aspects of 
your displays and reports.  But what if you need access to the full power of DDS? 

� Click on the EMPAPL field in the DDS Tree. 

� Press F5 or select Insert keywords from the pop-up menu.  You are taken to the Details page 

for the EMPAPL field and the Create keywords tab is selected in the Utilities notebook.  This 
page shows you the subset of keywords that are allowed for the selected file, record or field 
and it takes into account the field’s type, usage, shift and what record it is in.  It is very 
powerful to know exactly what your options are.  This information cannot be quickly 
ascertained from the Reference manual. 
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� With the EMPAPL properties notebook at the Basics page.  Click on the  button to 
change the field to numeric type.   Notice that the list of keywords in the Create keywords 
page has changed. 

� Click on the  button to change the field back to alphanumeric.  Notice that the list of 
keywords in the Create keywords page has changed. 

� Click on the ALIAS keyword and press F1.  The DDS Reference help for the ALIAS 
keyword appears.  It is important to mention that the CODE Designer has lots of on-line help.   

� Feel free to press F1 anywhere you want to see help for an item, icon or notebook.  You will 
get help relevant to what you are currently trying to do.  From the Help menu you can get 
quick access to the DDS Language Reference as well as several other useful sources of 
information. 

� Minimize the help window. 

� Double click on the INDTXT keyword.  (You may have to scroll to the right to find it).  The 
keyword is created with default values which can be changed at your leisure 

� Double click on the INDTXT keyword again.  The keyword will be created with the same 
default values thereby creating a conflict.  Not to worry – this is deliberate – we want to use 
it to show you how to resolve errors later on. 
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Verifying Your Source 

We have just added a new record and some new fields to our DDS source.  Everything that the 
CODE Designer adds to your DDS source is certain to have the correct syntax.  Now we need to 
make sure that there are no semantic errors.  We just introduced one in the last section by 
creating two INDTXT keywords describing the same indicator. 

� From the Tools menu, select Verify file (or click on the     button on the main toolbar).  
The DDS source is checked using the same verifier 
that the CODE Editor uses.  A message appears on 
the status line at the bottom of the designer stating 
that the verify completed with errors. 

� In the DDS Tree, there is a trail of red x’s leading 
to the culprit.  The file icon has a red x, as does the 
SELECT record, the EMPAPL field and finally the 
second INDTXT keyword. 

� Click on the MAIN_MENU tab in the workbook.  
The EMPAPL field is highlighted in red. 

� Click on the Listing tab in the workbook.  This 
page shows you the listing generated by the most recent program verify.  A warning message 
is buried somewhere in the listing but it’s not easy to find. 

� If there are problems, they will show up in the Error list page in the Utility notebook. It 
behaves exactly like the Error list in the CODE Editor.  Click on the Error list tab. 

� Double-click on the warning DDS7861 in the Error list.  (Hitting F1 would get detailed help 
on the message).  The Source page appears and the cursor is placed exactly where the error is 
in the source.  The Source page is a tokenized read-only view of the current state of the DDS 
source.  Read-only?  Wouldn’t it be nice if you could just zap the error right here?  Some 
things are just plain faster in the editor and many others are faster in the visual environment.  
It would be great to switch between the two modes at the push of a button 
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Switching between Design mode and Edit mode 

� Click on the  button or select the FileÆ Edit DDS Source menu item.  You now have 
access to the full power of the editor. 

� Explore the Edit and View pull downs. 

� Press Ctrl-F to bring up the Find/Replace dialog 

� Type in INDTXT and hit the Find button. 

� Press Ctrl-N to find the next occurrence 

� Delete the second INDTXT line using Ctrl-Backspace or by any other method you like. 
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Compiling Your Source 
 
Now we will compile the source on OS/400 just as we did in the CODE Editor. 
 
� From the File menu, select Save to save your source to the host. 

� From the Tools menu select Compile and then select No prompt (or click the   button on 
the main toolbar).  A message will tell you when the compile is complete.  Click on the OK 
push button in the message dialog. 

� If you run the PAYROLL program, you will see the 4 digit year change you made to the 
opening screen of the program. 

 
Closing CODE Designer 
 

� From the File menu, select Exit.   


